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Student Support Sheet
PC/laptop
Microsoft Disability Answer Desk
Get support with Office, Xbox accessibility and Windows
https://www.microsoft.com/en-us/Accessibility/disability-answer-desk 
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Microsoft Word
· Change the background colour of your page
Changing the colour of the page can help you to read and write more easily. Go to the Design tab and then click on Page Color at the top right hand side of the page. Experiment with the theme colours or choose More Colors to have even more choice.

· Change the font, size and colour
Changing the font can also help when reading and writing. From the Home tab, click on the drop-down box in the Font section to see the different possibilities. 
From the font area on the Home tab, you can also increase the size of the font and change its colour. All of these things can make studying a little easier.

· Use ‘Speak’ to hear text spoken aloud
If you have Word through your university Office 365 account you will be access Learning tools. This can be found in the View tab.
[image: ]
Selecting this will give you the option of formatting your text or using Read Aloud to have your work read back to you. This is very useful when you are proofreading your work.
[image: ]
· Spelling support
When Word identifies an incorrectly spelled word, Word will underline it with a red line. If you right-click on this word, Spelling will give you the option of hearing the word read aloud from the drop-down menu.
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· Autocorrect
Use Autocorrect to add words that you know you find difficult to spell. You can add them in an abbreviated form so that you do not need to type them out in full each time. Go to File….Options….Proofing and then select Autocorrect Options.
For example, instead of typing out quantitative you could add the abbreviation ‘quan’. When this has been added to the list, every time you type quan followed by a space, comma or full-stop, the full word will come up. It will even have a capital letter if it is at the start of a sentence. 
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Snipping tool
The Snipping tool is available within Windows 10, Windows 8, Windows 7 and Windows Vista. You can find it by searching for it from the Start button. It works like Print Screen but you can be more precise in the information you are capturing from the screen. See the examples below:
Example of Print Screen:
[image: ]

Example of Snipping Tool:[image: ]
Once the Snipping Tool box comes up, select NEW and then select the area you wish to copy. This is automatically copied and is ready for you to paste into a document.

Windows Colour Inversion
Go to the START menu on the main screen. 
Click on the SEARCH Icon and search for MAGNIFIER  
Click on the app tile. 
When the MAGNIFIER mini tool bar appears, click on the SETTINGS icon 
From the list, select the box that says INVERT COLOURS. The screen should turn black with white writing. 
To cancel this action, unselect INVERTED COLOURS from the settings menu and click on the CLOSE cross at the top of the MAGNIFIER mini tool bar. 

Websites
Natural Readers
https://www.naturalreaders.com/online/
Text to speech online. Add documents, copy and paste or type in text to the box and you can hear it read back to you. Although there is a premium version of this site, there are free voices which give unlimited usage. The sentence will change colour as it is being read aloud so that you can keep track of your place in the text.



Speechnotes
https://speechnotes.co/
Speech to text online. This site works very accurately from the internal microphone within a PC/laptop or you can use a headset with microphone. Simply click on the mic button and start dictating. Your spoken words will be automatically converted into text. This text can easily be copied and pasted into a word document, or you could copy it into the Natural Readers page and hear it read back to you. 

Spreeder
https://www.spreeder.com/app.php
The website version of the spreed extension. Copy and paste the text you wish to speed read and click on the SPREED button. In the settings dropdown you can change the speed of the words as well as things like the font and background colour. This software allows you to focus on one word at a time and could make reading a little easier.

Quizlet
https://quizlet.com/en-gb
An account in Quizlet will sync with the app which is available on both android and iOS. Quizlet allows you to create your own set of study cards which can be really useful for revision. You can learn and test yourself.

The Codpast
https://thecodpast.org/
An online publication for students with dyslexia giving news and views on technology, study skills, employment, events and entertainment. 

Fonts to improve readability
Both of these fonts can be downloaded and will be added to the list of fonts in Microsoft Word:
Dyslexie font: https://www.dyslexiefont.com/
OpenDyslexic font: https://opendyslexic.org/
These fonts have different weightings to the letters, but also slightly more space between the letters and words which can stop the text from feeling so ‘crowded’. Just ensure you change your work back to the specified font before submitting an assignment.

The Writer: Style Guide
http://www.thewriter.com/what-we-think/style-guide/ 
From here you can find useful information such as when you should write a number as a word or a figure, when to use a colon or a semicolon and when you should use capitals or lower case letters. 

Google Chrome Extensions
Google Chrome extensions customise how you browse. Search for Google Chrome Store and then find the following: 

VoiceNote II – Speech to text 
Click on the icon of the world and then scroll to English to select the language. Click on the microphone, then begin speaking. The text can be saved as .txt file or copied and pasted into a Word document.
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Read Aloud: A Text to Speech Voice Reader
Settings allow you to change the voice, speed, pitch and volume. The text can also be highlighted but this will appear in a separate box. 
[image: ]

OpenDyslexic
The webpage will be displayed in OpenDyslexic font and can easily be disabled. The spacing between the letters can make it easier to read the text on the page. This does not work if you are downloading the page as a pdf. [image: ]


Easy Read
This does not change the font but adds more spacing to letters and lines of text on the page. This can make the text easier to read.
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Spreed – speed read the web
Depending on the settings, one word (or more) will be displayed on the screen at a time until all of the text has finished. The number of words per minute can be changed. 
[image: ]


[bookmark: _GoBack]Todoist: To-Do list and Task Manager 
Create an account to easily add tasks to your to-do list. This can be synced to your phone (iOS and android). 
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Ultidash – New Tab
Productivity dashboard. This allows you to set a concentration timer and block your distracting websites. It can be linked to a Gmail account, Todoist account and your Google calendar. It will keep track of your site visits and display them as a percentage of your day or total time.
[image: ]

Apps
iOS and Android
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	Quizlet
Create your own study notes and revision cards
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	Todoist: To-do lists for task management & errands
Create to-do lists, set a task and reminder. Syncs across many devices.
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	OneNote
An online notebook to store ideas, text, bullet points, images, audio recordings, links etc. 
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	Office Lens
Take a photo of text/the whiteboard, convert to PDF, Word or PowerPoint file and save to OneNote, OneDrive or your device.
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	Self-help Anxiety Management
Self-help methods for managing and understanding your anxiety
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	Calm: Mindfulness and Meditation app
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	SpeechNotes –  Speech to Text (Android)
Converts your spoken words into text. Free but with some ads.
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	ClaroSpeak Assistive notepad with Text To Speech (iOS)
Highlights the text as it is read aloud. Also with different font and colour settings.

	[image: Image result for be my eyes LOGO]
	Be My Eyes 
Connects blind and visually impaired people with sighted volunteers and company representatives for visual assistance 
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image3.png
AZ o

=S AZ )

Column Page | Text Syllables Read Close
Width - Color - Spacing Aloud  Learning Tools

Learning Tools Close

‘7‘\‘6‘\‘5‘\‘4‘\‘3‘\‘2‘\‘1‘\‘8‘\‘1‘




image4.png
I like to tipe on my keyboard.

type
X cut kind, font, key
ER Copy tape i
& - adhesive tape, cassette, ribbon
tip
r:'A landfill, slope, gratuity
£ Smart Lookup Add to Dictionary
B3 Translate Ignore All
& Link » |[@ SeeMore
43 New Comment





image5.png
AutoCorrect: English (United Kingdom)

Show AutoCorrect Options buttons.
Carrect TWo INitial Captals. s
Capitalize firs letter of sentences

Capitalize first letter of table cells

Capitalize names of days

Correct accidental usage of cPS LOCK key

Replace text as you type

Replace: With: (@) Plaintext () Formatted text

quan quantitative|

quater quarter ~

quaters quarters

quesion auestion

uesions | questions v
Add

Automatically use suggestions from the spelling checker

ok Close





image6.png
[ soLE X/ @ Al Guides - Library Serv X \( [ University of Worcester: - X o — x
A NS | e e -\
G (2 [ Universyof Worceste 681 | sy ranyiorcacuk AEECE R

Wrting a paragraph  [1 AT [ Presanxiety Kel Assignment Sunvival @) Home - fstpaint - U

apps M Using stble tomsr. M Wiriting a Critcsl e, @) All Guides - Library ¢ [ Funcsmentalsof Ar ) Dissbled Students' 4 @ Lesrn a New Skil O[3 UniRdg_Librarys ke @) Pick s Tutoris (Liber

IR\ University I EE——S————
Q) Rt

P N

Guides ~

Home  About ~  Resources ~ Services ~  Help & Contact us ~

o
2
H
H
=

3
3
=
H
s
=

General

Search articles, books, eBooks and other Library items.

[

More search options

Borrowing and access Subject guides Referencing
Find out how many books you can borrow Organised by Institute, our Academic Everything you need to know about
reservations you can make and how to use Liaison Librarians have put together lists of referencing in your subject with links to
other university libraries helpful databases and journals from our guides and support

collections and also free online resources





image7.png
Borrowing and access

Find out how many books you can borrow
reservations you can make and how to use
other university libraries

Subject guides

Organised by Institute, our Academic
Liaison Librarians have put together lists of
helpful databases and journals from our
collections and also free online resources

Referencing

Everything you need to know about
referencing in your subject with links to
guides and support




image8.png




image9.png




image10.png
Open
Dyslexic




image11.png




image12.png




image13.png
G todoist





image14.png
. ultidash

the utimote
productivity dashboard





image15.png
()




image16.png
y

A\




image17.png




image18.png
8
L




image19.jpeg




image20.jpeg




image21.png




image22.png




image23.png




image24.png
Find us on:
facebook.





image25.png




image1.png
icing ~

|

]

Watermark Page  Page
- Color ~ Borders

Page Background




image2.png
Home Insert Draw Design

| [Zloutline | 4 Ruler | [E One Page D’j
D Draft I;-(,) q BE j}

Gridlines ; Multiple Pages
Read Print Web Learning o Zoom 100% ) New
Mode Layout Layout Tools Priifiom G B Page Width o ow
Views Immersive Show Zoom
I . 2 L4 6:1:7 1.8





image26.jpeg
Q University
of Worcester

Student Services




